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Introduction

To get maximum versatility from this machine all operators should carefully read and follow the in-
structions in this manual. Please keep this manual in a handy place near the printer.

Please read the Safety Information before using this printer. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be
liable for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.

Appletalk, Apple, Macintosh, Mac OS, Mac OS X isaregistered trademark of Apple Computer, Incor-
porated.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

The proper names of the Windows operating systems are as follows:

* The product name of Windows® 95 is Microsoft® Windows 95.

+ The product name of Windows® 98 is Microsoft® Windows 98.

+ The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

+ The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition
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 The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

+ The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

» Microsoft® Windows NT® Workstation 4.0

Notes:

Certain options might not be available in some countries. For details, please contact your local dealer.
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1. Using PostScript3

Setting up Options

This documentation describes the specific printer functions and menus that are added by installing the
PPD file. For more information about the functions and menus of the Windows 95/98/M e PostScript
printer driver, see the printer driver's Help.

= Preparation
On a Macintosh, Mac OS 8.6 or later (Mac OS X Classic environment is supported.) or Mac OS X
10.1 or later is required.

b 4 Limitation

O If you use Mac OS X, the following functions cannot be used:
e Sample Print
» Locked Print
* User Code

Job Type

Use thisto select the type of print job.
The following table shows the tabs or menus where you can select this function.

Windows 95/ 98/ Me [Job Type] on the [Setup] tab.

Windows 2000, Windows XP [Job Type] on the[Job/ Log] tab in the Printing Preferences dialog box.
Windows NT 4. 0 [Job Type] on the [Job/ Log] tab in the Document Defaults dial og box.
Mac OS [Job Type] on [Job Log] in the print dialog box.

Mac OS X Thisfunction is not available.

You can select the following items: l )
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O Normal
Select thisfor normal printing. The print job startsimmediately after the print command is given.

& Note
O Under Windows 95/98/Me, if you want to use an User ID, click the [Detail] button.

OO0 Sample Print
Use this function to print only one set of a multiple print jobs.
The other sets are saved in the machine. The saved job can be printed from the machine's control
panel. Y ou can also delete the saved job.

? Limitation

0 To use this function, the optional Hard Disk Drive must be installed on the printer.
& Note

O The "User ID" can consist of up to eight alphanumeric (a- z, A- Z, 0- 9) characters.
O Entering the "User ID" helps you to distinguish the print job from others.

A Reference
For more information about how to use Sample Print, see p.7 “How to Use Sample Print”.

O Locked Print
Usethisfunction to save documentsin the machine memory with apassword, and then edit and print
them as you want.

? Limitation
0 To use this function, the optional Hard Disk Drive must be installed on the printer.

& Note

0 The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters. The "Password"
must be four digits.
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A Reference
For more information about how to use Locked Print, see p.10 “How to Use Locked Print”.

How to Use Sample Print

Follow the procedures to print a document using the "Sample Print" function.

& Note

O If the application has a collate option, make sure that it is not selected before sending a print job. By
default, sample print jobs are automatically collated by the printer driver. If the collate option is se-
lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

l] From an application, select the menu command to print.
The print dialog box appears.

ﬂ Open the Printer Propertiesto set Sample Print.
B Click to select the [Setup] tab.

ﬂ Select [Sample Print] in [Job Type].

B ciick [Details...

E Enter the" User ID" in [User ID]. Thiscan consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
characters.

& Note
O Select this to identify the user associated with the job.




<

W ciick [0k

Windows 2000, Windows XP, Windows NT 4.0

ﬂ From an application, select the menu command to print.
The print dialog box appears.

ﬂ Open the Printer Propertiesto set Sample Print.
B Click to select the [Job/ Log] tab.
ﬂ Select [Sample Print] in [Print Job].

B Enter the" User ID" in [User ID]. Thiscan consist of up to eight alphanumeric (a- z, A- Z, 0- 9)
characters.

& Note
O Select this to identify the user associated with the job.

E Click [OK] to closethe Printer Properties.

ﬂ Start printing from the application's print dialog box.
The Sample Print job is sent to the machine and one set is printed.

B Check the sample print to confirm that the settings are correct.
If the settings are correct, see "Printing the Remaining Sets' in the Client Reference.
If not, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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Mac OS

ﬂ From an application, select the menu command to print.
The print dialog box appears.

ﬂ Click to select [Job Log] from the pop up menu.
B Select [Sample Print] in [Job Type], and then select the appropriate setting.

ﬂ Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters.

& Note
0 This is used to identify the user associated with a job.
O The "User ID" can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

B After making all of the settings you want, click [Print].
The Sample Print job is sent to the machine and one set is printed.

E Check the sample print to confirm that the settings are correct.
If the settings are correct, see "Printing the Remaining Sets' in the Client Reference.
If not, you can delete the saved job. See "Deleting a Sample Print File" in the Client Reference.
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How to Use Locked Print

Follow the procedures to print a document using the "L ocked Print" function.

& Note

O If the application has a collate option, make sure that it is not selected before sending a print job. By
default, locked print jobs are automatically collated by the printer driver. If the collate option is se-
lected in the application print dialog box, more prints than intended may be printed.

Windows 95/98/Me

ﬂ From an application, select the menu command to print.
The print dialog box appears.

ﬂ Open the Printer Propertiesto set Locked Print.
B Click to select the [Setup] tab.

ﬂ Select [Locked Print] in [Job Type].

B Click [Details...].

E Enter the " User ID" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters. Then enter a password in [Password], up to four digits.

& Note
O Select this to identify the user associated with the job.

W ciick [0k

g
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Windows 2000, Windows XP, Windows NT 4.0

ﬂ From an application, select the menu command to print.
The print dialog box appears.

ﬂ Open the Printer Propertiesto set Locked Print.
B Click to select the [Job/ Log] tab.
ﬂ Select [Locked Print] in [Print Job].

B Enter the " User I1D" in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters. Then enter a password in [Password], up to four digits.

& Note
O Use this to identify the user associated with the job.

E Click [OK] to closethe Printer Properties.

ﬂ Start printing from the application's print dialog box.
The Locked Print job is sent to the machine.
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Mac OS

ﬂ From an application, select the menu command to print.
The print dialog box appears.

ﬂ Click to select [Job Log] from the pop up menu.
B Select [Locked Print] in [Job Type], and then select the appropriate setting.

ﬂ Enter the “User ID” in [User ID]. This can consist of up to eight alphanumeric (a-z, A-Z, 0-9)
characters. Then enter a password in [Password], up to four digits.

& Note
0 This is used to identify the user associated with a job.
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Collate

Use this function to enable collation. With this feature, the printer can efficiently print collated sets of
multiple-page documents.

b 4 Limitation

O To use this function, a Memory Unit of at least 128MB or Hard Disk Drive must be installed on the
printer.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Collate] on the [Setup] tab.

Windows 2000, Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Printer Features] on [Document Options] on the[Advanced] tabin the
Document Defaults dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog box.

Mac OS X The [Collated] check box on [Copies & Pages] in the print dialog box.
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Duplex Printing

Use this function to select duplex printing.

b4 Limitation

0 To use this function, the optional Duplex Unit must be installed on the printer.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Duplex] on the [Setup] tab.

Windows 2000, Windows XP [Print on Both Sides (Duplex)] on the [Layout] tab in the Printing Pref-

erences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab in the

Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X The[Print on both Sides] check box on [Duplex] in the print dialog box.
Y ou can select the following items. The following items may vary depending on the operating system
you are using.

Windows 95/98/Me
O Off

Disables Duplex Printing.

O Open to Left
Prints output so that you can open it to the left.
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O Open to Top
Prints output so that you can open it to the top.

Windows 2000, Windows XP, Mac OS, Mac OS X

& Note
O If you use a Macintosh, click to select the button that means [Flip on Long Edge] or [Flip on Short Edge].

O None
Disables Duplex Printing.

O Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the short edge.

O Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the long edge.

Windows NT 4.0

O None
Disables Duplex Printing.

O Short Side
Prints output so that you can open it to the short edge when bound along the short edge.

O Long Side
Prints output so that you can open it to the long edge when bound along the long edge.
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Color Mode

Use this to select whether the document is printed in color or black and white.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Color/Black and White] on the [Setup] tab.

Windows 2000, Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dial og box.

Windows NT 4.0 [Printer Features] on [Document Options] onthe[Advanced] tab inthe
Document Defaults dialog box.

Mac OS [Color Mode:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Mode] on the [Features 1] tab on [Printer Features] in the print
dialog box.

& Note

O If you use Windows 95/98/Me, this mode is called "Color/Black and White".
Y ou can select the following items:

O Color
Prints color documents in full color.

& Note

O Color images will be printed using CMYK toner, Cyan, Magenta, Yellow and Black. CMYK are
three primary subtractive colors.

O If you want to adjust the print color, adjust the settings in the Advanced dialog box accessed from
the Advanced button on the [Print Quality] tab.

g
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O Black and White
Prints everything, including color documents, in black and white. Black and White printing isfaster
than Color printing. To stop black and white areas being printed with CMYK toner, select [Black
and White] in the printer driver as well asin the application.

Staple

Use thisfunction to have the output stapled. When you turn Staple on, the printed document is collated
automatically. Y ou should switch off Collate from the Print window of your application to prevent the
entire job from being stapled together.

? Limitation
O To use this function, the Finisher must be installed on the printer.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Staple] on the [Setup] tab.
Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences Properties.
Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tab.
Mac OS [Staple:] on [Printer Specific Options] in the print dialog box.
Mac OS X LStapIe] onthe [Features 3] tab on [Printer Features] in the print dialog
OX.

Y ou can select the following items. The following items may vary depending on the operating system
you are using.

l y
,//
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Windows 95/98/Me

O Off
Disables stapling.

O Top Left
Staple marks print on the top left side. The staple is placed parallel to the left side.

O Top Right
Staple marks print on the top right side. The stapleis placed parallel to the right side.

Windows 2000, Windows XP, Windows NT 4.0, Mac OS, Mac OS X

O Off
Disables stapling.

O Top Left
Staple marks print on the top left side. The stapleis placed parallel to the left side.

O Top Right
Staple marks print on the top right side. The staple is placed parallel to the right side.

O Bottom Left
Staple marks print on the bottom left side. The staple is placed paralel to the left side.

O Bottom Right
Staple marks print on the bottom right side. The staple is placed paralel to the right side.
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Paper Selection

Paper Sources and Output Tray Tabs

Use this to select the mediatype, input tray, and output tray.

? Limitation
O This function is for Windows 95/98/Me only.

A Reference
For more information about the [Paper Sources and Output Tray] tabs. See the printer driver's Help.

Paper Size

Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Size:] on the [Paper] tab.

Windows 2000, Windows XP [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in the Print-
ing Preference dialog box.

Windows NT 4.0 [Paper Size:] on the[Page Setup] tab in the Document Defaultsdialog
box.

Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

Mac OS X [Paper Size:] in the Page Setup dialog box.

A Reference

For more information about the paper sizes supported by this printer, see "Paper and Other Media
Supported by This Printer" in the Maintenance Guide 2.
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Media Type
Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.
Windows 95/98/Me [Type:] on [All Pages] on the [Paper] tab.
Windows 2000, Windows XP [Media:] on the [Paper/Quality] tab in the Printing Preference dialog
box.
Windows NT 4.0 [Paper/Output] onthe[Advanced] tab inthe Document Defaultsdialog
box.
Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog box.
Mac OS X [Paper Type] on the [Features 2] tab on [Printer Features] in the print
dialog box.
A~ Reference

For more information about the media type supported by this printer, see "Types of Paper and Other
Media" in the Maintenance Guide 1.
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Paper source

Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [All Pages] on the [Paper] tab.

Windows 2000, Windows XP The [Paper/Quality] tab in the Printing Preferences dialog box.
Windows NT 4.0 The [Page Setup] tab in the Document Defaults dial og box.
Mac OS [Paper Source:] on [General] in the print dialog box.

Mac OS X [Paper Feed] in the print dialog box.

Destination Tray

Usethisto select the output tray.
The following table shows the tabs or menus where you can select this function.
Windows 95/98/Me [Destination] on the [Paper] tab.
Windows 2000 [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences Properties.
Windows NT 4.0 [Printer features] on [Document Options] on the [Advanced] tab.
Mac OS [Destination:] on [Printer Specific Options] in the print dialog box.
Mac OS X [Destination] on the [Features 3] tab on [Printer Features] in the print
dialog box.
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Resolution

Use thisto set the resolution to [600dpi] .

b4 Limitation

0 The resolution option is only set to [600dpi].

Gradation

Usethisto select atype of gradation based on your purpose.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Print Quality] tab.

Windows 2000, Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Printer Features] on [Document Options] onthe[Advanced] tab inthe
Document Defaults dialog box.

Mac OS [Gradation:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Gradation] on the [Features 1] tab on [Printer Features] in the print di-
aog box.

Y ou can select the following items:

O Standard
Prints with good quality of gradation.

O Fast
Prints quickly while gradation loses some smoothness.




<

Color Profile

Use this to select the color profile pattern.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me

The [Print Quality] tab.

Windows 2000, Windows XP

[Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tabinthe
Document Defaults dialog box.

Mac OS [Color Profile:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Color Profile] on the [Features 2] tab on [Printer Features] in the print

dialog box.

Y ou can select the following items:

#¥Important

O If you use Windows 95/98/Me, you can configure [Color Profile] in [Advanced] by selecting [Manual]
from the[Color] setting. [Automatic] sets the printer to "Presentation”.

O Photographic

Use this setting to enhance the reproduction of photos and graphics that include midtones.

0 Presentation

Use this setting to enhance the reproduction of documents that contain text and graphics. This CRD
isbest for printing colored charts, graphs, presentation materials and so on. If you use this CRD for
printing photographs, the color or gradations might not be reproduced well.
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O Solid Color

Use this setting to print specific colors, logos and so on.

& Note

0 Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
should select the appropriate CRD for the document you are printing. The selected CRD is also re-
ferred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:
[Auto],[Photographic], [Presentation] and [Solid Color].

Color Setting

Use this to select the correction method used for color conversion.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me

[Advanced] on the [Print Quality] tab.

Windows 2000, Windows XP

[Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.

Windows NT 4.0

[Printer Features] on [Document Options] onthe[Advanced] tabinthe
Document Defaults dial og box.

Mac OS [Color Setting:] on [Printer Specific Options] in the print dialog box.
Mac OS X [Color Setting] on the [Features 1] tab on [Printer Features] in the print
dialog box.
i@klm portant

O If you use Windows 95/98/Me, you can configure [Color Setting] in [Advanced] by selecting [Manual]
from the [Color] setting. [Automatic] sets the printer to "Super Fine".
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& Note
O The color rendering dictionary that is selected in the "Color Profile" setting is used.

Y ou can select the following items:

O Off
No modification to the color setting.

O Fine
Select this setting to perform color matching based on one of the printer's built- in color rendering
dictionaries and perform CMYK conversion. This setting performs the printing which output target
isMonitor y=1.8.

O Super Fine
Select this setting to use a color rendering dictionary asin the "Fine" setting but produce output that
is more vivid. Use this setting to emphasize light colors. This setting performs the printing which
output target is Monitor y = 2.2.

& Note

0 Use this to select a color rendering dictionary (CRD). The CRD is referred to color matching, so you
should select the appropriate CRD for the document you are printing. The selected CRD is also re-
ferred to when [Fine] or [Super Fine] is selected for "Color Setting". The following items are available:
[Auto],[Photographic], [Presentation] and [Solid Color].
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Dithering

Use this to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.
Windows 2000, Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.
Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tabinthe
Document Defaults dialog box.
Mac OS [Dithering] on [Printer Specific Options] in the print dialog box.
Mac OS X [Dithering] on the [Features 2] tab on [Printer Features] in the print di-
aog box.
¥ Important

O If you use Windows 95/98/Me, you can configure [Dithering] in [Advanced] by selecting [Manual] from
[Color] setting. [Automatic] sets the printer to "Photographic”.

Y ou can select the following items:

O Photographic
Performs dithering using an appropriate pattern for photographs.

O Text
Performs dithering using an appropriate pattern for text.

O Graphics
Use this setting to perform dithering using a pattern appropriate for graphics such as tables and

graphs. r
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Gray Reproduction

Use thisto select the Black Color mode for text and line art.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.
Windows 2000, Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dial og box.
Windows NT 4.0 [Printer Features] on [Document Options] onthe[Advanced] tab inthe
Document Defaults dialog box.
Mac OS [Black Text/Graphics] on [Printer Specific Options] in the print dialog
box.
Mac OS X [Black Text/Graphics] on the [Features 2] tab on [Printer Features] in
the print dialog box.
i@klm portant

O If you use Windows 95/98/Me, you can configure [Gray Reproduction] in [Advanced] by selecting [Man-
ual] from the [Color] setting. [Automatic] sets the printer to "Pure Black Text".

@ Note

O If you use Windows 2000, Windows XP, Windows NT 4.0, Mac OS or Mac OS X, this function is
called "Black Text/Graphics".

Y ou can select the following items:

g
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O Pure Black Text
Select this setting to use a black toner.

& Note

O If you use Windows 2000, Windows XP, Windows NT 4.0, Mac OS or Mac OS X,, this mode is
called "K".

O CMY+K
Select this setting to use all toners.

Black Over Print

Select whether or not to apply ablack color over any other colors when printing.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Advanced] on the [Print Quality] tab.
Windows 2000, Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.
Windows NT 4.0 [Printer Features] on [Document Options] on the[Advanced] tabin the
Document Defaults dialog box.
Mac OS [Black Over Print:] on [Printer Specific Options] in the print dialog box.
Mac OS X [Black Over Print] on the [Features 2] tab on [Printer Features] in the
print dialog box.
i@klm portant

O If you use Windows 95/98/Me, you can configure [Black Over Print] in [Advanced] by selecting [Manual]
from the [Color] setting.

g
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Toner Saver

Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Toner Saver] on the [Print Quality] tab.

Windows 2000, Windows XP [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Printer Features] on [Document Options] on the [Advanced] tabinthe
Document Defaults dialog box.

Mac OS [Toner Saver:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Toner Saver] on the [Features 1] tab on [Printer Features] in the print
dialog box.

Color Control

Usethisto select whether or not you want the colorsin the documents to be adjusted before printing so
that the printed page matches closer to the colors on the screen.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me The [Print Quality] tab.

Windows 2000, Windows XP [Image Color Management] on [Graphic] on [Advanced] on the [Pa-
per/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0 This function is not available.

Mac OS [Print Color] on the [Color Matching] tab in the print dialog box.

Mac OS X Thisfunction is not available.
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& Note

O If you use Windows 2000 or Windows XP, this function is called "Image Color Management".
O If you use Windows NT 4.0, this function can not be configured.
O If you use Mac OS, this function is called "Color Matching".

O Image Color Control

Display the Image Color Matching dialog box, click this button to specify exactly how you want the
colors on your screen adjusted before printing.

User Code

Usethisto set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users and alows you to
check the number of sheets printed under each code with SmartNetMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [User Code] on the [Statistics] tab.
Windows 2000, Windows XP [User Code] on the [Job Log] tab in the Printing Preferences dial og box.
Windows NT 4.0 [User Code] on the[Job Log] tab in the Document Defaults dial og box.
Mac OS [User Code] on [Job Log] in the print dialog box.
Mac OS X Thisfunction is not available.

A Reference

For more information about using SmartNetMonitor for Admin, see Help.
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Options

See “Setting Up Options” in the Client Reference or the Administrator Reference for the installation
method appropriate to your printing environment.

The following table shows the tabs or menus where you can select this function.

Windows 95/98/Me [Option] on the [Accessories] tab.
Windows 2000, Windows XP [Option] on the [Device Setting] tab.
Windows NT 4.0 [Installable Option] on the [Device Setting] tab in the Document De-
faults dialog box.
Mac OS [Chooser] on the Apple Menu.
Mac OS X This function is not available.
O Tray 2

* You can select the tray with the following menu for PAPER FEED UNIT Type 5000:
Paper Sourcel] p.21

O Tray 3

* You can select the other tray with the following menu for an additional PAPER FEED UNIT
Type 5000:
Paper Sourcel] p.21

O Duplex Unit

* You can use the following function with Duplex Unit Type 5000:
Duplex Printing[] p.14
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O Hard Disk

* You can use the following function with Printer Hard Disk Type 5000:
Collatel] p.13
Staplel] p.17

& Note
0 The optional Finisher must be installed on the printer.
Job Typell p.5

O Mailbox

& Note
O Itis impossible to install the optional Mailbox and Finisher at the same time.

* You can use the following function with Mail Bin Type 5000:
Destination[] p.21

O Finisher

& Note
O Itis impossible to install the optional Mailbox and Finisher at the same time.
» Thefollowing functions are available with SR780:

Destination[] p.21

Staplel] p.17

& Note

O The optional Memory Unit of at least 128MB or the optional Hard Disk Drive must be installed
on the printer.

W
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O Total Memory
* You can use the following function with Memory Unit Type C (64/ 128/ 256 MB):
Collatel] p.13

& Note
O The optional Memory Unit of at least 128MB must be installed on the printer.
O This function is for Windows 95/ 98/ Me only.
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2. Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of the printer and so on.

b4 Limitation

O If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.

& Note
O Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers and Utilities”.

O Printer Utility for Mac requires Mac OS 8.1 or later. (Mac OS X Classic environment is supported.)
O Printer Utility for Mac cannot use Mac OS X (native environment).

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.
l] Start the M acintosh.

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

B Double-click theicon of hard disk to open it.

ﬂ Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

B Double-click the[Mac OS] folder.

E Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for Mac]
file, and then drop it into the Macintosh hard disk.

ﬂ Drag the CD-ROM icon and drop it into [Trash] to g ect the CD-ROM.
Printer Utility for Mac isinstalled. J—‘
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

i@klm portant
0 Before starting Printer Utility for Mac, confirm that the printer is selected with [Chooser] on the Apple

menu.
l] Double-click the Printer Utility for Mac icon.
The Printer Utility for Mac dialog box appears.

B ciick [0k

Printer Utility for Mac will take afew seconds to start.

A Reference
For more information, see “Printer Utility for Mac Functions”.
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Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

O File menu

[Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.37 “Downloading PS Fonts”.

[Display Printer's Fonts...]

Display and delete the fonts in printer memory and the printer's hard disk drive. See p.39 “Dis-
playing Printer's Fonts’.

[Initialize Printer's Disk...]

Initialize the printer's hard disk drive. See p.40 “Initializing the Printer Disk”.

[Page Setup...]

Set up the paper size to print “Printer Font Catalog” and “ Printer Font Sample”. See p.41 “Page
Setup”.

[Print Font Catalog...]

Print the names of available fonts. See p.41 “Printing Font Catalog”.

[Print Font Sample...]
Print a sample of fonts. See p.41 “Printing Font Sample’.

[Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.42 “Renaming the Printer”.

[Restart Printer]
Restart the printer. See p.43 “ Restarting the Printer”.
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O Utility menu

» [Download PostScript File...]
Download a PostScript File. See p.43 “Downloading PostScript Files”.

* [Select Zone...]
Change the zone to which the printer belongs to via Appletalk. See p.44 “ Selecting the Zone”.
+ [Display Printer Status...]
Display the status of the printer. See p.45 “ Displaying the Printer Status’.
 [Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See p.45 “Launching the
Dialogue Console’.

Downloading PS Fonts

Y ou can download the PS fonts to the printer's memory or hard disk drive.

i@klm portant
O The following procedures to download the fonts assume that you are a system administrator. If you
are not, be sure to consult your system administrator.

O If the printer restarts, all the printer settings return to their defaults.
O Confirm that a Macintosh and the printer are connected with Appletalk.

@ Note
0 Some fonts cannot be downloaded.

O Before downloading, read the documentation about the fonts you want to use.

l] Select [Download PS Fonts...] on the [File] menu.
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ﬂ Click [Add to list].
The dialog box to select fonts appears.

B Click to select the desired font files, and then click [Open].
Thelist of selectable font names appears.

ﬂ After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

B Click [Download].
The fonts begin to download, and the download status is shown.

i@klmportant

O During the download, do not turn off the power switch, operate the panel or open or close the
cover.

B When the completion message appears, click [OK].
ﬂ Click [Cancel].
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Displaying Printer's Fonts

Y ou can display the available fonts currently downloaded to the printer. Fonts in the printer's memory
and hard disk drive can be displayed.

& Note
O The fonts displayed in italics are the default fonts.

l] Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].
B Click [OK].

Deleting Fonts

Y ou can delete fonts from the printer's memory or hard disk drive.

l] Select [Display Printer's fonts] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].

B Select the fonts you want to delete.
? Limitation

O You cannot delete the fonts displayed in italic.

ﬂ Click [Delete].
A confirmation message appears.
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B Confirm the fontsyou want to delete and the printer name from which you want to delete the
fonts.

E Click [Continue], and then click [OK].
ﬂ Click [OK].

Initializing the Printer Disk

When initializing the printer's hard disk, al the fonts downloaded to the printer's hard disk drive are
deleted. Beforeinitializing, be sure to check the fonts on the hard disk drive.

i@klmportant

O When initializing the printer's hard disk drive from the operation panel, all of the data on the printer's
hard disk drive is deleted. Before initializing, be sure to check the data on the hard disk drive.

l] Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears.

& Note
O To cancel initialization, click [Cancel].

ﬂ Click [Execute].
Initializing starts.

i@klmportant

O Do not turn off the power switch until initializing is completed, otherwise the hard disk drive might
be damaged.

B When the completion message appears, click [OK].
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Page Setup

Y ou can set the paper size on which to print “Print Fonts Catalogue” and “Prints Fonts Sample”.
l] Select [Page Setup...] on the [File] menu.
ﬂ Choose the paper size.

Printing Font Catalog

Print the names of fonts available on the printer.

& Note
O The paper selected under [Page Setup] is used.

l] Select [Print Fonts Catalogue] on the [File] menu.
ﬂ Click [Print].

Printing Font Sample

Y ou can print samples of fonts downloaded to the hard disk drive or memory.

& Note
O Print by using the paper selected on [Page Setup].

l] Select [Print Fonts Sample...] on the [File] menu.
ﬂ Click [Print].
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Renaming the Printer

Y ou can change the printer's name displayed under Appletalk. If you connect severa printers on the
network, assign different names so you can identify them. If several printers have the same name, adigit
appears next to the printer name in [Chooser].

l] Select [Rename Printer...] on the [File] menu.
ﬂ Type a new namein the [New Name:] field.

? Limitation
O You can enter up to 31 digits and letters.
O Do not use symbols, for example “*”, “:", “=""@", “~".

B Click [Rename].
The printer name is changed.

ﬂ Press[OK].

B Select [Chooser] on the Apple menu.

B Click the [AdobePS] icon.

ﬂ Click to select the printer name renamed in step F], and then close [Chooser].

& Note
O If there are several Appletalk zones, select the zone to which the printer belongs to.
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Restarting the Printer

Y ou can restart the printer.
l] Select [Restart Printer] on the [File] menu.

ﬂ Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.

& Note
0 The fonts that you downloaded in the printer's memory will be deleted.

O If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

Y ou can download a Postscript file to the printer.
l] Select [Download PostScript File...] on the [Utility] menu.
ﬂ Select the file name to download and click the file name, and then click [Open].

B Typethelog file name, and then click [Save].
The selected file is downloaded.

& Note
O Errors are recorded in the log file.
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Selecting the Zone

Y ou can change the zone to which the printer belongsto via Appletalk.

i@klm portant
O Confirm that the printer and a Macintosh are connected in an Appletalk environment.

l] Select [Select Zone...] on the [Utility] menu.
The zone to which the printer belongs to and the available zone list appear.

ﬂ Select the zone to which you want to switch the printer, and then click [Change].
A confirmation message appears.

B Click [Continue].
A confirmation message appears.

ﬂ Press[OK].

B Select [Chooser] on the Apple menu.

B Click the [AdobePS] icon.

ﬂ Select the zone selected in step F] on the [Appletalk zone:] list.

B Click to select the printer you want to use on the [Select a PostScript Printer:] list.
ﬂ Close [Chooser].
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Displaying the Printer Status

Y ou can display and confirm the current status of the printer.

l] Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

ﬂ Confirm the current status of the printer.

Y ou can confirm the memory capacity, the VM (Virtual Memory) space, the hard disk drive status
and available space on the hard disk drive. Y ou can also confirm the zone to which the printer be-
longs to.

B ciick oK.

Launching the Dialogue Console

Y ou can create and edit a PostScript file for printing, and then download it to the printer.

i@klm portant
O “Launch Dialogue Console” is recommended for users with an understanding of PostScript.

O Do not download any file other than PostScript files to the printer.
O “Launch Dialogue Console” must be used at your own responsibility.

l] Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.
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ﬂ Type the PostScript command in the editor screen.

& Note
0 To edit a PostScript file, select [Open] on the [File] menu to open it.
O You can search or replace a character string by using the [Search] menu.

B After editingthePostScript file, select [Download Top Window] on [Console] menu to start print-
ing.
The PostScript file is sent to the printer.

& Note
O The [Reply from Printer] box opens, depending on the PostScript file you sent.

ﬂ Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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